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Versions 
 

Version Date Comment 
1.0 15 April 2010 Initial Release 
2.0 30 April 2010 Added Table of Courses in Part II 
2.1 4 May 2010 Removed dates; added Troubleshooting section. 
2.2 14 May 2010 Added item about slow response time in troubleshooting section 
2.3 7 June 2010 Added note below TOF; added Finance Overview.  
2.4 8 July 2010 Added note on Help in simulations. Fixed spacing in Troubleshooting 

section. 
4.0 21 October 2010 Corrected numbering. Added sections on retakes, transcripts, and 

generating Cert of Completion. 
5.0 7 January 2011 Added "Before you Enroll" section 
5.1 31 January 2011 Expanded information about TOC to include color as well as shape.  
6.0 2 May 2011 New POI tracks, new registration and launch procedures for ALMS Version 

2.0 (after downgrade) 
6.2 19 July 2011 Copyright Information added 
6.3  17 October 2011 Updates for ALMS Version 3.0 added; FAQ expanded 
6.4 1 January 2012 FAQ Expanded (registration), GCSS-Army-ALL types added 
6.5 1 April 2012 FAQ Expanded (cache) 
7.0 15 May 2012 New sections on testing and survey. Added Glossary. Substantial revisions.  
8.0 31 July 2012 Revisions to Learning Management tabs showing new +/- expansion 

system  
9.0 19 Nov 2012 Conversion to self-enrollment 
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Required Identification  
Access to GCSS-Army Web-Based Training (WBT) depends on thes factors: 

1. The student must possess a valid AKO (Army Knowledge Online) ID and password 
2. The AKO ID must be recognized by the ALMS (Army Learning Management System) database 

Please contact your supervisor or SASMO regarding assigment of an AKO ID. The AKO mailbox must remain 
open and available for delivery of information. ‘Generic’ IDs are not permitted.  

Hardware and Software Prerequisites 
Note: The GCSS-Army WBT may be taken on most PCs, but can also be completed on AGM (Army Gold 
Master) laptops. If you are using another kind of PC, please ensure that you have the following prerequisites 
for hardware and software before attempting to use the GCSS-Army training materials. Hardware and 

software information is available under My Computer (right click) → Properties. Internet versions are 

available in Internet Explorer under the Help → About menu.  

Hardware 

CPU:   Windows Pentium class machine, 1.2 GHz or higher preferred. Apple products not supported.  
RAM:   2GB minimum (more is better) 
Video:   Card & display must support 1024 X 768 at 96dpi, 32 bit color quality (high) preferred 
 
CD-ROM:  If CD-ROM is used as alternative delivery device, it must be accessible to the s/w; including 

any drive letter (DFAS USERS, PLEASE TAKE NOTE!) 
 

Software 

O/S: The GCSS-Army WBT is certified on Windows XP only

Browser: I/E 7 (minimum) or I/E 8 (preferred). Appears to function correctly on I/E 9. Not recommended 
for Mozilla Firefox. 

. It appears to work properly for 
Windows 7, but has not been extensively tested on that platform. Not recommended for 
Windows Vista. Do not use on Macintosh operating systems.  

 Cookies must be enabled. The pop-up blocker

Output:  None required. Work products cannot be saved. ALMS certificates will print on any standard 
networked or attached printer.  

 must be disabled. Browser pop-up windows 
must be enabled.  

  
CAUTION: 

  

Clear your Internet cache before starting WBT training. [Delete all temporary files.] 
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A Note about Network Speeds for GCSS-Army WBT 
The ALMS system is heavily utilized, both in terms of number of courses offered and number of students 
taking those courses. Consequently, response time can be slow during periods of heavy use – as much as 
several seconds to turn the page of a GCSS-Army lesson, and over a minute to launch a simulation. GCSS-
Army has absolutely no control over network speeds

To avoid problems with your ALMS session in AKO, please do the following: 

. 

1. Clear your Internet browser cache before starting GCSS-Army WBT

To clear the cache, open your Internet browser, pull down the Tools menu, and select Internet 
Options. On the General tab, the Browsing History options are the second set shown. Click Delete, 
then Delete All in the next menu. (If your security settings do not allow Delete All, delete the 
temporary files and 'cookies' instead).  

. (The 'cache' is a part of the 
Internet browser that remembers what Web sites you have visited, and tends to accumulate a lot of 
temporary files). Also delete unneeded 'cookies' – bits of information kept on your PC by web sites 
you have visited which identify you.  

2. Click buttons and menu items only once

      

. Normally, the GCSS-Army options will change color or 
'press' themselves in a three-dimensional fashion to show that they have been 'clicked'. Once the 
button changes, the request has been sent to the ALMS, and clicking again has no effect (or may 
cause JAVA exception errors).  An example of a changing button is shown below.  

Figure 1. NEXT button - original (left) and clicked (right). 

3. Wait for screens to open completely, including all backgrounds. Attempting to access items, 
 select options, add data, or print screens should not

4. 
 be done until the entire image appears.  

Try logging into AKO and ALMS in non-peak periods to improve your system's response time

GCSS-Army WBT on Alternate Web Sites 

.  
Least busy periods are before 0800 and/or after 1800. Also, try to avoid Monday mornings from  
0800-1000, and Friday afternoons from 1400-1700, when the site is busy.  

As of late 2012, the ability to take the GCSS-Army WBT courses from another web site (such as 
www.gcss.army.mil) exists, but this website contains only the GCSS-Army lessons (no tests, no survey,  
no certificates). This website is not under the control of the GCSS-Army LMS Administrator, and may not 
have the most up-to-date materials, but may be useful for those students whose GCSS-Army 
implementation is more than 180 days in the future.  

http://www.gcss.army.mil/�
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Figure 2. GCSS-Army Web Site. 

Certificates of completion for work done on the GCSS-Army web site were available for printing until 
summer, 2012. These may be submitted to the LMS Administrator for recording in the student’s ALMS 
transcript until 12/31/2012.  

GCSS-Army WBT on Your Desktop 
The ability to take the GCSS-Army WBT courses offline on a PC's desktop is being considered for the SABA 
Content Player v5.5, but is not yet available. Until then, another way of taking GCSS-Army WBT classes 
outside of the ALMS system is to request a copy of the courseware on CD-ROM.  

GCSS-Army WBT on CD-ROM 
This option should be reserved for the most extreme situations (very long distance from server, lack of AKO 
credentials, extremely short ramp-up time, etc) and requires pre-approval by GCSS-Army management, as it 
involves remaking the courses in a different format. Security issues (control of courseware, markings, and 
mailing of media) also become important factors. For additional information or to request alternate media, 
please send an e-mail to the Training e-mailbox.  

 

Figure 3. CD-ROM File Structure (partial). 
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Part 1 – ALMS Access Via AKO (Army Knowledge Online) 

Enrollment Prerequisites 
Access to GCSS-Army Web-Based Training (WBT) depends on these two  factors: 

• The student must possess a valid AKO (Army Knowledge Online) ID and password 

• The AKO ID must be recognized by the ALMS (Army Learning Management System) database 

Please contact your supervisor or SASMO regarding assigment of an AKO ID. The AKO mailbox must remain 
open and available for delivery of information. ‘Generic’ IDs are not permitted.  

Access Army Knowledge Online (AKO) 
1. Open your browser and navigate to https://www.us.army.mil. A screen similar to that below will appear.  

 

Figure 4. AKO/DKO Portal. 

  

https://www.us.army.mil/�


P.11 
 

2. Click the I Accept button to access the AKO login screen.  

 

Figure 5. AKO Login Screen. 

3. At the login screen, do one
a. Make sure your CAC card is inserted properly into the CAC reader and select FOUO Login. You 

will need to chose your DOD certificate and enter your CAC PIN to complete the login. CAC 
certificates must be current & published to Internet Explorer in order to be recognized; contact 
your SASMO for assistance if the CAC PIN screen does not appear.  (Preferred method) –OR– 

 of the following: 

  

Figure 6. Digital Certificates and CAC PIN. 
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b. Click the Non-FOUO Portal for the Username/Password hyperlink. (Non-preferred method). 
The screen above appears with the figure below replacing the FOUO Login. Enter your AKO 
Username and Password in the fields indicated and click Non-FOUO Login.  

 

Figure 7. Non-CAC Login. 

Note: If you are on a slow speed terminal, click the Low Bandwidth box before logging in. This method also 
requires you to answer KBA (security)questions which has been previously set-up.  

4. The AKO Home Screen will appear. If the login screen reappears, you have made an error during the 
login process. Check your username and password, or make sure the CAC is right side up and completely 
inserted into the CAC reader, then try again. If you still cannot login, call the AKO Help Desk (not

Access 'My Training' 

 ALMS 
or GCSS-Army) at 1-866-335-ARMY (2769) for assistance. 

1. Find the Self Service drop-down list at the top of the page.  

 

Figure 8. AKO Home Screen. 
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2. From the Self Service drop-down list, select My Training (or My Education).  

 

Figure 9. Self-Service Options List. 

3. The My Training screen will appear showing the ALMS (Army Learning Management System) 'gadget' in 
one of nine smaller windows (see below). [You may wish to use the Customize View option to center 
the ALMS window, or turn off unused 'gadgets' to help the ALMS gadget load faster.] 

 

Figure 10. ALMS Option in My Training. 

A security warning may appear. Click OK to continue.  

 

Figure 11. ALMS notice (scrolled down). 
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Scroll down and read the warning about pop-up blockers. Before proceeding into the ALMS, do the following; 

• With your browser open, select the Tools menu, then select Pop-Up Blocker, then select Turn Off 
Pop-Up Blocker.  

• If the pop-up blocker is off, leave it off, and press Esc.  

• A second pop-up blocker may also exist for your firewall. Contact your SASMO or SysAdmin if you 
have difficulty seeing ALMS or GCSS-Army WBT screens.  

Note: This check only needs to be done once, unless you have knowingly changed the settings. 

Course Registration 
As of late 2012, registration into the GCSS-Army WBT on the ALMS is the student’s responsibility, and is no 
longer dependent upon an e-mail request to the LMS Administrator. Students following the instruction in 
Part II of this Guide will be able to register for all courses, take the requisite exams, and print their 
Certificate of Completion without outside assistance. The LMS Administrator remains available to answer 
questions, resolve problems, investigate errors,  and generate periodic reports on students’ progress. 

Program of Instruction (POI) - Curriculum 

For ease of use, GCSS-Army WBT uses a single POI called ‘GCSS-Army ALMS Based Course’ consisting of 
eleven (11) lessons, as follows: 

1. GCSS-Army Overview 
2. GCSS-Army Basic Navigation 
3. GCSS-Army Intermediate Navigation (December, 2012) 
4. Using GCSS Army Reports 
5. Retail Supply Overview 
6. Material Management Overview 
7. Processing a Material Through GCSS-Army  
8. Organizational Supply Overview 
9. Maintenance Overview 
10. Finance Overview  
11. Spending Chain Overview 

All GCSS-Army users must

• Core Curriculum – Four lessons relevant to most system users 

 complete the POI by completing the following sections: 

• Functional Area (Overview) – A short introductory lesson to introduce an area of specialization, 
such as Warehouse or Finance 

• Functional Area (Additional) - Lessons developed to introduce a particular concept (such as the 
Spending Chain for Finance).  Not available for every Functional Area.  

• Exams – Multiple choice assessment tools to measure how well the student understood the 
materials. There is no exam for the GCSS-Army Overview lesson.  

• Survey – Feedback form for constant improvement of the WBT materials.  
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Recommended Lessons 
The Core Curriculum consists of WBT material relevant to most users of the system. Courses include: 

• GCSS-Army Overview

• 
 – A history and high level explanation of the GCSS-Army program. 

Basic Navigation [JAVA]

• 

 – The absolute necessities of entry and exit (logon / logoff), moving to and 
through menus and tables, how to create and use favorites, how to get help, etc. Simulations 
(guided learning) are also introduced.  

Intermediate Navigation

• 

 – Tips on sorting, filtering, finding; variants, layout, fields, and data 
manipulation (new in late, 2012)  

Using GCSS-Army Reports

The Core Curriculum is recommended for all GCSS-Army users  

 – An introduction to the look and feel of GCSS-Army reports; how to read, 
generate, 'drill down', manipulate variants, format, print, transfer, and store report information. 

• For students in the Retail Supply Functional Area, including: 
o   Warehouse - SSA Receiving, storing, and issuing goods 
o   Warehouse Managers - Stock control, inventory, and reporting 

• Take the Core Curriculum, plus Retail Supply Overview (Mods 000 and 001).  
 

• For students in the Materiel Management Functional Area, including: 
o   Supply Management I - Below SSA, Plant 2000 
o   Supply Management II - SSA & Above, Plant 2001 
Take the Core Curriculum, plus Material Management Overview and Processing Material Through 
GCSS-Army (Mods 000 and 002). 
 

• For students in the Organizational Supply Functional Area, including: 
o Property Book - Displaying, authorizing, transferring, requesting, and receipting of equipment 
o Asset Visibility - Displaying organizational data as it relates to materiel, viewing a materiel   

BOM, verify assigned NIIN/LINs 
o Unit Supply - Displaying, transferring, managing, inventorying, requesting and receipting of 

supplies and equipment 
o S4 - Displaying organizational data as it relates to materiel. Conduct due diligence, view a hand 

receipt, manage reservations from units 
• Take the Core Curriculum, plus Organizational Supply Overview (Mods 000 and 003/004). 

 
• For students in the Maintenance  Functional Area, including: 

o Parts Record Clerk - Weapon/equipment systems configuration and equipment readiness 
reporting, dispatch process, maintenance notification, and work order processing 

o Ground Maintenance Managers - Reporting tools used for planning resources for maintenance 
activities and analysis for equipment readiness  

o Master Drivers - Processes to record and maintain operator qualification profiles. Print Operator 
Permits and generate Qualified Operator reports 

• Take the Core Curriculum, plus Maintenance  Overview (Mods 000 and 005) 
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• For students in the Finance Functional Area, including: 
o  Resource Management - Daily/Weekly Activities, Budgeting, Cost Management, P/E, Y/E Close 
o  DFAS I - Process Journal Vouchers, P/E Close, Y/E Close 
o  DFAS II - Cash Balancing (UMC), Cash Balancing (UMD) 
o  DFAS III – Navigating Financial Reports (optional elective) 

• Take the Core Curriculum, plus Finance  Overview  and Spending Chain Overview  
(Mods 000 and 006) 

 
• For GCSS-Army  Leadership (including Commanders and Senior Staff) 

• Take the Core Curriculum (Mod 000) 

 
• For NET Instructors and new GCSS-Army personnel  

•  All GCSS-Army WBT courses  (All Mods) 

All Soldiers (and certain civilians) who will be working in GCSS-Army must

  

 complete the WBT. Failing to do 
so may result in a delay in taking Instructor Led Training (ILT), as well as certification testing – both of which 
are required to receive a GCSS-Army User ID and password.   
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Part 2 – Registering for WBT Courses 
Note: This procedure has recently changed significantly.  Please read carefully

Complete the steps above until you have accessed the ALMS Home Page, then continue with the steps 
below.   

.  

Searching the Catalog 
1. At the ALMS Home page, click the Catalog Search button.  

 

Figure 12.  ALMS Home Page (Catalog Search . 

2. The Search screen will appear as shown below.   

 

Figure 13. Search screen. 
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Change the fields in the Search screen as indicated below: 

• Course Iterations – Grayed out; cannot be changed 

• Search Text field – “GCSS” [one word only] 

• Show exact matches only – leave unchecked 

• Starting (drop down box) – No change (use default “In Next Six Months”) 

• Locations (drop down box) – Select “Any Location”  

 

3. Click the Search button . The screen will appear as shown below.   

 

Figure 14. Search screen - results. 
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Clicking the name of the course displays the Course iteration details (optional). Click the Back to Search 
Results button at the bottom of the screen to return to the previous screen.  

 

Figure 15. Course Iteration Details. 

Clicking the Title gives additional information (optional) 

 

Figure 16. Title details. 

Note

 

: This is a separate window - click the Close icon (  ) in the upper right hand corner to close it.  
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4. Back in the Search screen

 

, click the Register button under the course name (GCSS-Army-ALL ALMS 
Based). The following screen will appear.  

Figure 17. Create Order screen (top) . 

Note

 

: “Create Order” refers to creating an order (request) for the lesson. You cannot change the order of 
lesson titles on the screen, nor can you deselect lessons that are listed for GCSS-Army WBT.  

Figure 18. Create Order screen (bottom) - Continue Registration. 

Click the Continue Registration button at the bottom of the screen to continue.  The button will gray out 
and change to the word Processing… while registration is being completed.  
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The Registration Confirmation screen will appear. The Status column will show as Confirmed.  

 

Figure 19. Registration Confirmation screen. 

Click the Go to Enrollments button at the bottom of the page to continue. 

Note: The Notes entry in the Actions column is used to add information about the lesson.  Please do not

 

 use 
this feature at this time.  

 

 

 



P.22 
 

The My Enrollments screen will appear.  Do not change the tab, sort, title, or “Group Courses By...” fields. 

 

Figure 20. My Enrollments screen. 

Click the ‘plus’ sign ( + ) to the left of the lesson name to see the lesson titles and exams associated with it.  

 

Figure 21. My Enrollments screen – expanded module. 
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You can ‘unexpand’ the table back to a single line list by clicking the minus sign ( --  ).  

Please note that there are TWO “Launch” buttons, which launch different things: 

• The ‘outer’ Launch button (near the three digit Module number and name), which will display the 
module details, beginning with the Learning Assignments tab . 

• The ‘inner’ Launch button, near the lesson name and date, which launches the lesson itself.  

Click the inner Launch button to start the lesson or exam .  This will take you to the table of contents (TOC) 
[example shown below.]  Note that the TOC will appear on top of the Learning Assignments tab for the 
content you have launched. The Learning Assignments tab will keep track of your progress within a 
particular lesson.  

Figure 22. Learning Assignments Tab. 
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Dropping a Course  
The Drop option (in the More Actions box in the upper right of the Learning Assignments screen) allows the 
student to cancel participation in the course, and does not

 

 have to be confirmed. The Drop option is 
available by clicking the more actions link to the right of the Launch button. Click the Drop button at the 
bottom of the screen to drop a course.   

Figure 23. Drop Offering screen. 

Note: Do not drop a course without contacting your supervisor for permission first

Do Not Register more than once! 

. Your ALMS transcript 
will be considered incomplete until your GCSS-Army WBT courses have been completed (or manually waived 
by the LMS administrator).  

Once you have registered for the GCSS-Army WBT once, do not

Figure 24. Registration Error. 

 attempt to do so again. Attempting to 
register for the same course a second time causes the ALMS to display the figure below.

 

Click the Find Another Offering button to return to the search process.  
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‘Closing the Gap’ no longer a part of the registration process 
Until mid-November, 2012, registration for GCSS-Army WBT involved manual configuration of two ALMS 
profile items, which was handled by the LMS Administrator. Approximately 900 students were  
hand-entered into the ALMS system between early July and mid-November, 2012, using this approach, 
which was deemed too labor-intensive to continue past Wave 1 of system fielding.   

Students who registered for GCSS-Army WBT in the summer/fall of 2012 who have work in progress will be 
allowed to finish that work, but no new registrations will be allowed under the old training paradigm.  
Students attempting to register for the first time will be shown Figure 14 (above) after a simple search for 
“GCSS”, even if they previously received an e-mail notice that their registrations were complete.  

The older paradigm involved closing a competency ‘gap’ for two assigned/required tasks. Attempting to 
‘close the gap’ now displays the screen below. 

 

Figure 25. Close Competency Gap - No Longer Used. 

Note that there are no items in the table. If you see this screen, click the Cancel button (do not click the 
Competency Name).  You must return to the ALMS Main Menu and run a catalog search in order to find and 
register for the GCSS-Army WBT course.  
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Lesson Order  
As of late 2012, the modules of the “GCSS-Army-ALL ALMS Based” course may be taken in any order, 
allowing students to study whichever modules are most relevant to their responsibilities. Click the ‘plus’ sign 

( + ) to the left of the module name to expand any of the Functional Areas, the use the Launch button to 

start the lesson from there.  

GCSS-Army recommends the following lesson order for new students: 

• Core Curriculum 
o GCSS-Army Overview 
o Basic Navigation 

 Basic Navigation Exam  
o Intermediate Navigation 

 Intermediate Navigation Exam 
o Using GCSS-Army Reports 

 Using GCSS-Army Reports Exam 

• Functional Area Overview 
o Functional Area Exam 

• Additional Functional Area Lessons (Material Management and Finance Only) 
o Additional Functional Area Lesson Exams 

• Other Functional Areas of Interest 
o Other Functional Areas of Interest Exams 

• GCSS-Army WBT Survey 

Exams may be taken separately, if desired; however, training credit in the ALMS will not be granted unless 
both the exam and the lesson are taken (and passed) together.  The Survey should not be taken until the 
end of the course.  

Table of Contents and Lessons 
When the lesson is launched, the Table of Contents (TOC) will appear. Select the underlined

 

 blue entry of 
the course name to display the SABA Player.   

Figure 26. Table of Contents. 
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The small box at the right of the Table of Contents screen shows your progress, as follows: 

Box Fill Course Progress Color 
Empty/none Course not started None 
Half Full Course started, but not completed Green 
Full Course completed successfully (or assessment passed) Green 
Full Course completed unsuccessfully (or assessment failed) Red 

Notes: 

• A lesson which has not been started shows an empty box.  

• A lesson which is started, but not completed, shows the box as green, half-full. Such a course may be 
continued from the point the student closed the lesson. A prompt appears when the course is reopened, 
asking if the student would like to continue the lesson from the point at which it was left. If the student 
elects not to restart the course at that point, they are returned to the first page of the course. 

• The student may continue to take the lessons in the course in this fashion until the course is completed, 
in which case the box changes to green and full.  

Table of Contents and Assessments 
• All courses (except the GCSS-Army Overview) contain assessments (tests), which must be passed in 

order to receive certification for GCSS-Army WBT. 

• Completing the course and

• Failing to pass the assessment will change the box to full and red. 

 passing the assessment at the 70% level results in a full, green box in the TOC 

It is every student's responsibility to review the materials and re-take the assessment so that the TOC box is 
green and full. The number of retakes is limited to three (3). Assessment information can be found in the 
student's transcript, along with a numerical grade.  

Table of Contents and Surveys 
• The GCSS-Army-ALL ALMS Based course contains a survey about the WBT, which must also be 

completed. 

• A completed survey results in a full green box in the TOC. 

• An incomplete (unsubmitted) survey results in a full red box in the TOC. 
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The WBT's SABA Content Player 
When the course is launched in the ALMS, the SABA Content Player will start. Click the expand icon (  ) 
in the upper right corner to make the window full size.   

 

Figure 27. Course shell (full screen). 

Note: The course is best when viewed at 1024 X 768 pixels and 96 DPI. If necessary, you can change your 

screen resolution by clicking Start → Control Panel  → Display → Settings (in Win XP) and changing the 
settings in the Display Settings screen. This can be done without closing the lesson. If you cannot increase 
your screen resolution to 1024 X 768 pixels, contact your SASMO for assistance.   

Warning: When taking WBT courses, do not

The TOC window is a normal component of any SABA WBT course, and in most cases, will not be noticed.  
If other documents or folders are open, however, the possibility of accidental closure increases.  For this 
reason, the WBT windows should be the only items open on the desktop when you are taking GCSS-Army  
WBT training courses.  

 close the Table of Contents (TOC) window that is open behind the 
SABA Content Screen. Closing this window interferes with the communication between the student and the 
ALMS and can cause your progress (or course completion) to be incorrectly recorded.  

To gain the maximum screen area for the course, turn off the bottom bar of the browser (Status Bar). Select 
the View menu in Internet Explorer and uncheck the Status Bar option to do so.  
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1. Press F11 to completely maximize the lesson window (this removes the upper Internet Explorer bars).   

2. Click the green arrow (  ) in the lower right corner to begin the course.  

 

Figure 28. Course shell (maximized, no Status Bar). 

3. Complete the training course by following the on-screen instructions. Use the arrow keys at the bottom 
right corner of the screen (, ) to move through the course. Use the Close icon in the upper right 
corner to close the lesson and return to the TOC.  

4. Some courses (Basic Navigation, Intermediate Navigation, and Using Reports) contain simulations, which 
allow the student to get a feel for moving around in the GCSS-Army system without actually being 
connected to it.  Such courses display several page with a graphic similar to the figure below.  

The two choices (Demonstration and Training) function as follows: 

• Demonstration mode is a non-interactive overview of the concept - just watch and learn!  
 

• Training mode guides you through each step in the transaction. You will need to make entries on the 
keyboard, or use the mouse to select specific fields and options on the screen.  
 

Some versions of the WBT may contain a single choice (Training mode) only. Other courses may contain an 

icon (  ) to launch the course, rather than a separate window.  Simulations using an icon are normally 

accompanied by the written procedure, also shown by clicking an icon (  ). 
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Figure 29. Simulations Portal. 

5. Double click either choice to launch the simulation. A security warning screen will appear (possibly more 
than once.) Click Yes to continue.  

 

Figure 30. Security Warning. 

WARNING: If using an AGM 10 machine with the Win7 operating system to run the WBT, the phrasing of 
this statement is different. In this case only, click No to continue. 

A set of three dots moving from left to right will show the progress of the simulation load. [It is normal for 
the dots to stop moving during the load process, which can take 60-90 seconds.]  

 

Figure 31. Simulation load in progress, 

When finished with the simulation, follow the directions to exit and return to the simulations portal. You 
may repeat the simulation multiple times, or change modes from Demonstration to Training, or vice-versa. 
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6. There is no Certificate of Completion for individual lessons, although your enrollment status will change 
in the Enrollments table .  

7. Exit the final page of the lesson by clicking the Exit Lesson button. Be sure to press F11 to return your 
screen to its original size. Also be sure to reset the screen resolution and Status Bar, if necessary. 

8. Close the SABA Content Manager screen by clicking the Close icon () in the upper right corner of the 
lesson screen. After closing the Content Manager, you may close the Table of Contents screen the same 
way.  

9. The ALMS system will return you to the My Enrollments screen. From here, you can launch the exam for 
the course.  

Final Notes 

• Click the  button for additional information on the icons, rollovers, and 
buttons in the lesson.  

• Click the Close icon () in the upper right corner of the lesson screen to leave the lesson at any 
time.   The ALMS will remember your last location within the lesson, and offer that page when you 
return. You may select this location or restart the course from the beginning.  

• In the GCSS-Army Help window, the Screen Resolution and Computer Safety links are not currently 
active.  The workaround for accessing this information is to click the colored tabs immediately to the 
right of the links. 

 

Figure 32. GCSS-Army Help - Table of Contents. 

• You may exit and re-enter any GCSS-Army WBT course as many times as you like. However, once 
you have completed the course (lessons, assessment, and survey), the listing will disappear from 
your Enrollments screen. Contact the ALMS Help Desk for assistance in relaunching the materials.  
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• There is no time limit for the course, and students should proceed at their own pace.  Timeouts and 
disconnects may differ based on local security policies. The ALMS will timeout after four (4) hours. 
The approximate time required to complete the course is shown on the Welcome screen. 

• Once finished with the WBT, be sure to log out of AKO, and close your browser for additional 
security.  

• Individual and collective progress through the POI is monitored by GCSS-Army personnel and 
periodically reported to the Army PMO for distribution to unit commanders. We suggest you finish 
the POI at least 15-20 days before the GCSS-Army system goes live at your installation.  

• Statistics on WBT also include total time spent in the ALMS system. Please do not rush through the 
WBT materials, as that fact will be noted in the reports as well . 
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Completion of other lesson materials 

 

Figure 33. Learning Assignments tab – Table Showing Progress. 

When the course content is completed, the Learning Assignments table will change as shown above. Note 
that the Content portion of the course has been completed successfully. At this point, the content may be 
re-launched, or the exam may be launched for the first time.   

Note that the Enrollments screen has a separate Launch button for the exam.  

  

 Figure 34. My Enrollments table – Basic Navigation components shown. 
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A multiple choice exam (see Section 3) follows the lesson material. This exam must be passed at the 70% 
level before credit is given. Questions are derived from the information on the lesson pages.   

 

Figure 35. Learning Assignments Tab – Module and Exam. 

When the exam is completed successfully, the Learning Assignments tab will change as shown below. Three 
attempts are allowed, and a score and completion status are shown on the Learning Assignments tab, as 
shown below. 

 

Figure 36. Learning Assignments tab – Module and Exam Passed Successfully. 

Note: All POIs have a minimum of one course and one exam. Finance and Material Management POIs have 
two courses and two exams; the Core Curriculum has four courses (but only three exams).  Your overall task 
is to take a minimum of five (5) WBT courses, successfully pass the exams on four of them, and then 
complete the Survey as the final step.  
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 Once all lessons and exams are completed, the student should complete the final component, which is the 
end-of-class WBT survey. 

 

Figure 37. My Enrollments table after all elements completed. 

At this point, the student would expand and launch the end of course survey (see Section 5).  
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Part 3 – Assessments (Exams) 
By direction of the AESIP PM, all GCSS-Army WBT lesson (with the exception of the Overview) now have an 
assessment (exam), which will follow completion of the course materials

To begin the assessment, click the exam’s Launch button on the My Enrollments screen. Be sure the 
assessment module number matches the course module, as shown in the following example: 

. This assessment is a multiple 
choice test of between 10 and 20 questions (depending on functional area), designed to measure whether a 
student successfully attained the objectives for the lesson. Questions and answers were developed by the 
same development staff that created the WBT and ILT materials. The Q&A was approved by the Master 
Trainers, who taught the initial classes at Ft. Irwin and Ft. Bliss in 2010 and 2011, respectively.  

POI Course Assessment (Exam) 
Material Management –  

Module 2 
Material Management Overview – 

Module 2.0 
Material Management Exam – 

Module 2.0.1 
 

The front page of the assessment is similar in most cases and resembles the figure below.  

Figure 38. Assessment Front Page. 

To begin the assessment, click the Next button. Do not

The Contents block will show the various sections of the assessment, which map to the sections in the 
course.  

 use the Table of Contents hyperlink to start the 
questions. THE EXAM MAY BE SLOW TO START. PLEASE WAIT AT LEAST 60 SECONDS FOR THE EXAM FRONT 
PAGE TO APPEAR.  

To leave the assessment and take it at another time, click Exit.  
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A sample question from an assessment appears below.  

 

Figure 39. GCSS-Army Assessment Sample Question. 

Important Information about GCSS-Army assessments. 
• All questions are multiple choice, with FOUR choices, but only ONE correct answer. Some questions 

contain graphics to assist you.  

• All assessments allow you to move back and forth between questions. No score is calculated until 
you click the Submit button on the last page of the assessment. 

• All assessments may be exited at any point by clicking the Exit button. When you re-launch the 
exam, however, you will have to retake the exam from the beginning.  

• The passing grade on all exams is 70% [level established by TRADOC]. 

• All material for the exam is derived from the WBT course slides. Questions are concept-based (no 
manipulation of the GCSS-Army system is required to arrive at the correct answer.) 

• If you fail to reach the minimum passing score, you may retake the exam a maximum of  three (3) 
times.  However, if you cannot pass the test after second attempt, we advise you to carefully go 
through each page, perform each rollover, click, and simulation possible, and perhaps take notes.  

• Anti-cheating measures have been incorporated into the questions and answers. To gauge your 
understanding accurately, please CLOSE the course materials before taking the assessment. 

Scores will be shown automatically after the Submit button is clicked. Please give the ALMS sufficient time 
to redisplay the page (the screen refresh is automatic, but may take 60 seconds or more).  
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What Questions Did I Get Wrong? 
To determine which of your responses were incorrect, follow this procedure:  

1. Click the My Home tab, or choose My Home from the drop-down box in the top center of the screen. 

 

Figure 40. Detailed Training Records servelet. 

2. When the My Home tab appears, click the Detailed Training Records portlet. The table below will 
appear at the bottom of the screen. (You may need to scroll down to see the table, or right to see 
Actions

 

) 

Figure 41. My Detailed Training Records screen, table. 

Note: You may also print your Certificate of Completion from this screen. Click the Print Certificate of 
Completion 

You may only print the certificate if the Completion Status reads Successful and the Print option is 
underlined (available). 

option in the Completion Status field. A standard Print dialog will appear; select your printer 
and print options (change to Landscape for best image), then click OK.  

3. To display the progress report, move the mouse to the Actions column, and position the pointer over 
the word Actions. The pop-up balloon shown below will should appear in a few seconds (if not, click the 
word Actions

 

). Click View Content. 

Figure 42. Actions Menu. 
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4. The Progress Report  for the module will appear. Click the underlined module name in the far left 
column (here, GCSS-Army Material Management Exam).  

 

Figure 43. Progress Report - Material Management Exam. 

5. To display the module, move the mouse to the Actions column, and position the pointer over the word 
Actions. The pop-up balloon shown below will should appear in a few seconds (if not, click the word 
Actions

 

). Click View Results by Lesson. 

Figure 44. Actions Screen - View Results by Lesson. 

The Results screen will appear, as shown below.  

 

Figure 45. Results by Lesson - Material Management Exam. 
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6. To display the module, move the mouse to the Responses column, and click Responses

 

. The  following 
screen will appear. 

Figure 46. Responses Table. 

Note that the table will display the question number, question description, YOUR response, and whether 
or not YOUR response was correct or incorrect (as well as other data for the developer).  [The Response 
column in the figure above has been deliberately erased because it contains actual test verbiage, not 
just numeric choices.] Since the test can be retaken multiple times, there is no way to directly determine 
the correct answer from this table.  

7. To return to the portlet screen, click the My Home tab.  
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Part 4 – WBT Survey 
Both Northrop Grumman Corporation (NGC) and the U.S. Army realize the critical value of feedback from 
students when it comes to the continuous improvement of the GCSS-Army training materials. The 
electronic/paper form for Instructor Led Training (ILT) has been modified to apply to the Web based 
training, and MUST be completed in order to finish the course. Surveys are completed anonymously and 
contain no PII.  

The WBT Survey may be launched after the last assessment (exam) is completed. GCSS-Army recommends 
that it be completed immediately after the last assessment is passed, so that impressions of the course are 
still fresh in your mind. Your transcript will NOT show the POI as complete until the survey is also complete. 

The survey provides the student a unique opportunity to comment on various aspects of the WBT training, 
using a combination of five-point scale questions and comment boxes. To start the survey, click the Launch 
button in the My Enrollments screen. The survey's first screen will appear, as shown below.  

 

Figure 47. GCSS-Army WBT Class Survey - Screen 1. 

The first set of questions is for classification purposes only. Please be as accurate as possible when 
answering these questions. 

  

Figure 48. GCSS-Army WBT Class Survey - Question 1. 
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Most questions allow only a single response. Some questions (see the figure below) allow multiple boxes to 
be checked. These questions will have the instruction "Please check all that apply". 

 

Figure 49. GCSS-Army WBT Survey - Multiple Inputs Allowed. 

You can move back and forth through the survey by using the Previous and Next buttons. You may also Exit 
the survey at any point, and re-launch it at another time (although this is not recommended). If you exit in 
this manner, you can submit the survey in its current form, or exit without saving your choices. If you then  
re-enter the survey, you will have to start over at the beginning.  
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Figure 50. GCSS-Army WBT Survey - Text Input Allowed. 

Some questions allow for text input of up to 300 characters (about three lines). These questions allow you to 
comment on the GCSS-Army WBT, so that we can make it better for the next person who uses it.  

Note: Comments that are off-topic, or contain inappropriate/obscene language will not be considered. 
Please, watch your spelling and STICK TO THE SUBJECT at hand.  This is NOT the place to complain about 
dissatisfaction with the GCSS-Army program; such complaints should be directed to the chain of command 
or e-mailed to the ALTESS Service Desk: altess.servicedesk@us.army.mil . 

Statistics (including comments) from the WBT survey are gathered periodically, combined with other statistics 
and reported to GCSS-Army management and the Army PMO, where they are reviewed for content and 
possible action. If, however, you have significant issues with any aspect of the WBT, please send an  
e-mail to the GCSS-Army Training inbox (GCSSArmyTrainingHELP@ngc.com) as soon as possible.  

  

mailto:altess.servicedesk@us.army.mil�
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Part 5 – Certificates and Transcript Information 

 Certificates 
There are two kinds of certificates available for GCSS-Army WBT:  

• The ALMS Certificate

• The 

, available from the within the ALMS system itself, shows lesson name, title, 
and date of completion. This is a black-and-white certificate, signed by the Director of Distributed 
Learning Systems (DLS) at Radford, VA.  

GCSS-Army Certificate, available at the end of GCSS-Army WBT course only

o As of January, 2013, all training credit requests for these certificates have been entered into 
the ALMS system for previous GCSS-Army installations. Further requests for this certification 
must carry a manager’s signature and will be reviewed on a case-by-case basis. 

 when the course is 
taken from the GCSS-Army website or CD-Rom (outside the ALMS). This is a color certificate, without 
signature. As of September, 2012, this certificate is no longer available in the ALMS version of the 
course.  

The ALMS allows the student to print a certificate as proof that record of the successful completion of  
GCSS-Army WBT has been moved to the student's ALMS transcript. The certificate is available for printing 
under Detailed Training Records using the Print option on the 6th column of the table.  

Note: Successful completion of GCSS-Army WBT course materials (inside or outside the ALMS) does not

Samples of each certificate are shown below. 

 
award credit in the ATTRS system.   

 

Figure 51. Sample Certificate of Completion – ALMS (Signature block removed). 
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Figure 52. Sample Certificate of Completion - GCSS-Army Web Site Only (OBSOLETE).  

Note: The signature block has been removed from the examples above.  

• The date for the certificate is generated automatically. The format cannot be changed. 

FAQ on Certificates 

• To print in a 'Landscape' (sideways) orientation, look for the Properties button in the Print menu, 
then look for the Page Layout (or Layout) options and change the setting to Landscape. 

• Printing to paper is the preferred method of output. Printing to a file (such as a .PDF file) is not 
recommended.  

• There is now a certificate available for the completion of each module of the GCSS-Army WBT. All 
are available in the student’s transcript (see below).      

OBSOLETE 
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Printing a certificate 

To print (or reprint) an ALMS certificate, access the Detailed Training Records from the ALMS Main Menu 
and be sure the Training tab is showing, Check the completion date range, and change it if necessary to 
include the date you finished the WBT course. Select the Print Certificate of Completion option (under the 
Completion Status column) for the appropriate course.  When the certificate appears, click the printer icon 
to bring up a standard print dialog. Be sure to change the printer properties to Landscape to ensure the best 
print image.  

Retaking a course 
Partially completed course work is 'bookmarked' at the point where the user exited the course. Restarting 
the course brings up a menu asking whether you would like to continue from that point, or restart the 
course from the beginning.  

To retake a completed course, go to the ALMS Main Menu and select Detailed Training Records (see below).  
The system will display a screen similar to that shown below. 

 

Figure 53. Retaking a Course Module - 1. 

Click the Actions button, then click the View Content selection in the pop-up menu.  



P.50 
 

 

Figure 54. Retaking a Course Module - 2. 

To restart the module, click the Launch button to display the Table of Contents (note the small box is solid 
green, indicating completion). There is no limit to the number of times a particular lesson can be opened.  

Displaying Detailed Training Records (Transcripts) 
A transcript is a list of completed courses. To show your ALMS transcript, log into the ALMS, then select the 
Detailed Training Records option (first row, third column of the Home page). A page similar to the one 
below will appear.   

 

Figure 55. My Detailed Training Records page. 

If you need to check your score or print an ALMS Certificate of Completion, you can do so from the  
My Detailed Training Records table under the Completion Status column. 
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Figure 56. Printing the Certificate of Completion in ALMS. 

Click the Print Certificate of Completion option in the status column to bring up a standard Windows print 
dialog box.  

Adding Completed Courses to Your Transcript 

All courses COMPLETED in the ALMS are automatically added to a soldier's transcript. If the course does not 
appear in the Detailed Training Records table in 24 hours, please send e-mail to:  

GCSSArmyTrainingHelp@ngc.com 

for assistance in recording the course completion. All claims of course completion will be verified before 
credit is given.  

  

mailto:GCSSArmyTrainingHelp@ngc.com�
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GCSS-Army Access after certification 
Completion of the GCSS-Army WBT curriculum or POI does not automatically grant you access to the 
GCSS-Army system!  

The successful completion of a GCSS-Army WBT curriculum is, however, a prerequisite for additional ILT 
(instructor-led) training, which is normally offered starting about 30 days prior to the system going live at a 
particular location. The ILT and its (independent) certification tests must be completed and passed before 
system access is granted.  

Access to GCSS-Army requires, at a minimum: 

• Supervisory/managerial approval.  

• Completion of any and all documentation required for system access. 

• Signed agreement covering correct use of the system, as well as data and password protections.  

Most Army personnel should begin the process of requesting access by contacting their supervisor and 
requesting access, which is usually granted when the system goes live.  Questions can be directed to  
the GCSS-Army Help Desk at (800) 981-3234 for more information.  

Internal NGC & contract personnel may request access by sending e-mail to gcss-armysapsecurity@ngc.com  
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Appendix - Troubleshooting 
Question/Problem Possible Solution/Comment 
Who can I call for assistance? • For problems with your AKO UserID or 

password, call the AKO Help Desk at  
1-866-335-ARMY (2769).  

• For problems with ALMS system, call the 
ALMS Help Desk at (877) 251-0730.  

• For questions about GCSS-Army training 
(WBT/ILT) call the GCSS-Army Help Desk at  
(800) 981-3234 or DSN 231-3480 or send  
e-mail to: altess.servicedesk@us.army.mil 

• For network problems, call the CONUS TNOSC 
(800) 305-3036, or (520) 538-6798 or  
DSN: 879-6798.  

• For GCSS-Army system access, send an e-mail 
to gcss-armysapsecurity@ngc.com. 

I'm familiar with SAP. Do I still need to take the 
GCSS-Army WBT training? 

YES. The WBT courses are prerequisites to the ILT 
courses being taught by the Army SMEs. If you 
have not completed the WBTs, you should not 
take the ILT courses.  

I don't have an AKO account. Can I take the WBT 
courses some other way?  

YES. Go to https://www.gcss.army.mil and select 
the Education tab. The WBT classes are listed on 
the left side. Note this is NOT the preferred way 
of taking WBT classes because there is no way to 
track your progress. You must have permission to 
complete a  POI in this manner.  

Can I download the WBT courses to my PC? Currently, this option is not available due to 
SABA limitations.  

Do I have to take the WBT courses in order?  NO. We recommend you take Core Curriculum 
first, but functional overviews may be taken in 
any order.  Lessons should be taken before 
exams, but exams may be taken alone if 
necessary.  

I can't find the GCSS-Army courses in the ALMS. Make sure you are search for the string “GCSS” 
(not “GCSS-Army”) and using a Simple Search 
(not Advanced Search). If you still cannot find the 
course, please call the ALMS Help Desk.    

My Table of Contents has two identical entries. 
Which one do I use?  

Use the one with the hyperlink (blue underline). 
(The second entry will be used when there are 
additional WBT courses.) 

My Launch buttons are grey and nothing happens 
when I click them.  

The ALMS is off-line for maintenance. The course 
will not be available until the Launch button 
contains blue text 

When I try to launch the course, I get the 
message "Web page not available" or  
"Error 404 (File Not Found)". 

The course has been taken off-line for 
maintenance, or the ALMS is unavailable or 
experiencing problems. Check with your SASMO, 
or the ALMS Help Desk. 
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Does the WBT connect to and/or use the actual 
GCSS-Army system? 

NO. The large number of soldiers using the 
system would require either a separate training 
database, or a nightly refresh of the database 
information. The network load would also be an 
issue. The problem was solved by using the 'real' 
GCSS-Army system to create simulations of work 
flows, and record that data with commentary for 
later playback. 

After launching the course, I still have browser 
information (bars) at the top and bottom of the 
screen. 

Press F11 to go to full screen mode. Pull down the 
View Menu and uncheck the Status Bar box to 
eliminate the lower bar.  If the F11 key does not 
work, the option for full screen mode is also in 
the View Menu.  

After launching the course, the Content and 
Results page appears, with the message "You 
cannot mark the course complete" or similar 
message. 

The ALMS is running slowly. Please wait for the 
Table of Contents to appear in the upper left 
corner of the screen. In high traffic times, 
network response can be very slow, especially for 
large courses.  

My screens look distorted and/or do not match 
those in the text.  

Make sure your screen is full size, and that the 
resolution is set to 1024 X 768 pixels, even if your 
screen will support a higher resolution. Color 
quality should be set to High (32-bit). Dots per 
inch (DPI) must be set to 96 (the default). 
Remember to apply your settings before exiting 
the Display Properties screen. Also, check the 
ZOOM indicator in the lower right corner of the 
screen to be sure it is set at 100%. If you cannot 
view or change these settings, contact your 
SASMO.  

I'm getting a blank white screen between WBT 
screens, or screens are forming slowly.  

This is normal for WBT materials constructed for 
SCORM compatibility and displayed on the GCSS-
Army website. How fast the slides change is 
dictated by network load, and is not under GCSS-
Army control. A delay of 3-5 seconds may occur if 
the network is very busy.  

The simulations page takes a long time to load.  A separate executable is used to display and run 
the simulations; it can take 60 seconds or more to 
launch the first time it is used. Security warnings 
and network load can also slow their launch.  

I get one or two pop-ups warning me that the 
screens contain 'non-secure' material when I start 
the simulations.  

Click Yes whenever the pop-up appears (this 
feature is not under GCSS-Army control.)  If you 
run more than one simulation per lesson, the 
number of pop-ups will typically decrease each 
time you start a NEW simulation. THERE IS NO 
CLASSIFIED MATERIAL CONTAINED IN ANY  
GCSS-ARMY WBT OR SIMULATION. 
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I get a third pop-up window after launching a 
simulation warning me that "Voice –Over is 
disabled".  

Exit the course and inform your SASMO. Your PC 
is not configured correctly for GCSS-Army WBTs. 

When I launch my simulations, screen text and 
buttons are distorted or out of place, or I have a 
box with a red "X" () where I should have a 
graphic. 

Exit the course and inform your SASMO. Your PC 
is not configured correctly for WBTs, or there are 
missing images in the simulations. This normally 
indicates an incorrect file path.  

When I am in a simulation (demonstration or 
training) and click the Help icon ? , the Help 
screen does not appear. 

Click the Help icon again, or press Alt + Tab. (The 
Help screen is behind the active screen.) 

There is no instruction on the simulation's first 
page on how to begin running the simulation 
screens.  

The bottom of your screen is hiding the 
instruction.  See above for tips on increasing the 
screen area. Press ENTER to start the simulation 
in Training mode, or click the Play button in the 
lower toolbar for Demonstration mode.  

I'm stuck! My system appears to be frozen. If there has been no response to a simple 'turn 
the page' action for 60+ seconds, close the lesson 
by clicking the Close icon () in the upper right 
corner of the screen. You can try relaunching the 
course from the Table of Contents, or closing the 
ALMS completely and logging in again. If the 
problem persists, call the ALMS Help Desk.  

Can I exit the course and then pick up where I left 
off? What about the assessment and the survey? 

YES. ALMS will ask you if you want to continue 
from where you stopped work, or start over. 
There is no difference in the way you launch the 
course.  If you exit the course while taking the 
assessment, you must, however, retake the 
assessment from the beginning.  

Can I retake the course and jump between 
topics? 

YES, after you have completed a lesson topic. 
Use the Table of Contents slide to help you 
navigate through the topics.  

I completed the lesson (or passed the 
assessment) but I cannot print my Certificate of 
Completion. 
 
 

The ALMS system records completion at the 
modular level. You must complete the lesson and 
its requisite exam successfully in order to receive 
credit in your transcript. If your transcript reads 
Unsuccessful, but your numeric exam grade is 
>70, please send e-mail to the GCSS-Army 
Training mailbox (next page).  

I get a "JAVA Null Pointer Exception" error when I 
attempt to exit the course.  

This may be a cache issue. Close the error window 
by clicking the Close icon () in the upper right 
corner, or by clicking the Next button. If the 
Learning Assignments tab does not reappear or 
your course progress is not shown correctly, 
please call the ALMS Help Desk for assistance. 
Delete your Internet cache before starting 
another course.  
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I have lost my GCSS-Army WBT Certificate of 
Completion; can I get another one? 

Requests for copies of certificates can be sent to 
GCSSArmyTrainingHelp@ngc.com.  Most requests 
will NOT be honored as these certificates must be 
created from old templates no longer used. A 
manager’s sign-off on the request is necessary. 

I have lost my ALMS Certificate of Completion; 
can I get another one? 

To reprint an ALMS certificate, go to My Detailed 
Training Records in the ALMS and be sure the 
Active tab is showing. Check the completion date 
range, and change it if necessary to include the 
date you finished the WBT course. Select the 
Print Certificate of Completion option (under the 
Completion Status column) for the appropriate 
course.  When the certificate appears, click the 
2nd icon in the toolbar (  ) to bring up a standard 
print dialog. Be sure to change the printer 
properties to Landscape to ensure the best print 
image.  

Can I retake the assessment? YES. However, only one assessment score and 
one 'completion' status will be recorded. Hence, if 
you have scored above the minimum level for the 
assessment, there is no need to retake the exam. 
A maximum of three retries is permitted.  

How long do I have to complete the GCSS-Army 
WBT training? 

You have 180 days from the date you first 
registered to begin the training or you will be 
automatically disenrolled.  

Is there a 'sandbox' system where I can practice 
what I have learned? 

NO. The difficulty with a training ('sandbox') 
system is creating and maintaining viable data 
sets when a large number of students attempt to 
run transactions simultaneously. Due to the time 
and expense involved with such a system,  
GCSS-Army has elected not to use one at this 
time.  

Can I print to an external file rather than a 
printer? 

To transfer the certificate to another file, use the 
Print Screen function on your keyboard to copy 
the certificate to the Windows Clipboard, then 
paste it into Word and save or print from there.  
Do not use the options in the Print dialog to print 
directly to a PDF, which may cause errors . 

I have completed the initial read-through of the 
WBT materials, and used the TOC to review a 
previous section. My page numbers now appear 
to be missing or incorrect.  

Exit the lesson and clear your Internet cache. 
When you re-enter the lesson, the page number 
will have reset themselves correctly.  
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The Forward arrow is disappearing when I review 
the Knowledge Check questions.  

In the Knowledge Check, the idea is to force an 
answer from the student, and not to let them 
proceed until the choice is correct. Hence, the 
question begins with no forward arrow, and one 
does not appear until a correct choice is made. 
When the correct option is chosen, the forward 
arrow appears, and the student can click it to 
move to the next page.  
 
If a student elects to move backwards to review   
a previous Knowledge Check question, and clicks 
the Back arrow, the WBT reverts to the previous 
page, but leaves the correct option selected in 
the answer button (grayed out).  The Forward 
arrow, however, disappears again – the logic for 
the IF statement doesn’t cover going backwards. 
The key here is that the student MUST click the 
CORRECT answer option again (even though the 
grey dot is already there) in order to obtain the 
Forward arrow and proceed. 
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Glossary 
 

Acronym  Definition/Explanation 
AGM Army Gold Master (a type of laptop PC) 
AKO  Army Knowledge Online 
ALMS Army Learning Management System 
DFAS Defense Finance & Accounting Service 
DLS Distributed Learning Systems 
DPI Dots Per Inch 
EPSS Electronic Performance Support System 
GCSS-Army Global Combat Support System – Army 
https HyperText Transfer Protocol (Secure) 
ILT Instructor-Led Training 
NGC Northrop Grumman Corporation 
PII Personally Identifiable Information 
POI Program of Instruction 
SABA Company providing the WBT Content Player 
SASMO Sustainment Automation Support Management Office 
TOC Table of Contents 
UMC Unmatched Collection 
UMD Unmatched Disbursements 
WBT Web-Based Training 
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